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Copyright  The SpecWare 7 Professional software product (SOFTWARE) is owned by 
Spectrum Technologies, Inc. and is protected by United States copyright laws and 
international treaty provisions and all other applicable national laws.  You may not copy 
the user documentation accompanying the software without Spectrum’s permission. 
 
Grant of License  This license agreement permits you to use one copy of the 
enclosed version of the SOFTWARE on a single computer and make one copy for 
archival purposes. 
 
Other Restrictions  You may not reverse engineer, decompile or dissemble the 
software. 
 
Support  Support for the SOFTWARE is provided by the company that sold you the 
Software. 
 
No liability for consequential damages  To the maximum extent permitted by 
applicable law, in no event shall Spectrum Technologies or its suppliers be liable for 
any direct or indirect damages whatsoever, arising out of the use or inability to use this 
product.  In any case, Spectrum and its supplier’s entire liability is limited to the amount 
actually paid by you for the SOFTWARE.  
 
IMPORTANT: The disease and insect models used by SpecWare have been 
validated by state university plant pathologists for the regions of the United 
States in which they were developed.  To determine the validity and appropriate 
use of a particular disease model for your specific growing region, please 
consult with your State Agricultural Extension Service. 

1.1 Software License Agreement1.1 Software License Agreement1.1 Software License Agreement1.1 Software License Agreement    
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System Requirements 

SpecWare requires a 486 (or better) processor with at least 8 
megabytes of RAM running Windows 95 or better.  Windows 2000 or 
later is required for operations that require auto-scheduling 
(Autodownload, Frost alerts, and web datafile creation).   You will also need a mouse 
and a free serial port to connect the logger to the computer.  SpecWare 7 Pro requires 
a screen resolution of at least 640x480.  If the screen resolution is only 640x480, then 
the Windows Taskbar Properties must be set to "Auto hide" so SpecWare 7 Pro can 
use the bottom 1/2" of the screen.  To change the Taskbar Properties, right-mouse 
click on any empty area of the Taskbar (the gray bar at the bottom of the screen).  
Click on "Properties."  Ensure that "Auto hide" has a check mark next to it.  When 
"Auto hide" is checked, it is generally recommended that "Always on top" also be 
checked.  Click "OK" to save any changes.  

Installing SpecWare on a Hard Drive 

To install SpecWare software onto your hard drive, insert the SpecWare CD into the 
appropriate drive of your computer and follow the on-screen instructions.  If auto-start 
is not enabled on your computer, select Run from the Start menu and type D:\setup 
(Substitute the appropriate drive letter for your CD or floppy drive.)  The default 
location for program installation is C:\Specware, but you can specify a different location 
if desired.   

Connecting to Your IBM Compatible 

The logger is connected to your computer with an interface cable.  The PC-3.5 cable is 
designed to connect directly between the IBM compatible’s DB-9 (9-pin) serial port and 
the data logger.  A USB-Serial adapter (available from Spectrum or at your local 
computer store) may be needed if your computer does not have an available DB-9 
port.   

Upgrading from Prior SpecWare Versions 

If you have a prior version of SpecWare already installed on a given computer, it is 
recommended that SpecWare 7 be installed in the same directory as the existing 
version.  Multiple versions of SpecWare can co-exist without interfering with one 
another.  Data files from earlier versions must be imported into SpecWare 7 before 
they can be viewed and manipulated.  SpecWare cannot convert SpecWare 7 data 
files to a format compatible with earlier versions. 

1.2 Software Installation1.2 Software Installation1.2 Software Installation1.2 Software Installation 
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1.3 Testing1.3 Testing1.3 Testing1.3 Testing    the Com Portthe Com Portthe Com Portthe Com Port    

Identifying the Correct Com Port 

The computer Communications Port to which the PC interface cable is connected can 
be identified by using a paper clip.  This test is performed with the cable disconnected 
from the logger. 

1. Go to the Communications tab of the Preferences screen (see p. 8). 

2. Select the com port to be tested and click on the Test Port button.  If the message 
“Connection OK” is displayed, another device (such as a modem) is probably 
connected to that port. If the message “No Connection” is displayed, this port may be 
the one connected to your serial cable and you can proceed to the next step. 

3. Place a paperclip on the end of the serial pin so that it touches both the tip of the pin 
and the metal area between the two black rings.   Again click on the Test Port button.  
If the message “Connection OK” now appears, this is the com port connected to your 
serial cable.   

paper clip 

or wire 

 
NOTE: The Original dataloggers do not short-circuit the serial pin.  Therefore, when the 
Test Port button is clicked while the logger is connected, a “Bad Data Returned” 
message will be displayed. 

Testing a Connection to a 2000-Series Logger 

In addition to testing the PC interface cable, the connection to a 2000-Series logger 
can easily be checked by plugging the cable into the logger’s data port and hitting the 
2000 button in the Preferences screen Refer to the Communications tab of Prefer-

ences screen p. 8). 

USB-Connection 

With newer personal computers, an RS-232 serial port may not be available.  If you 
cannot establish communication with the serial port, a USB-RS232 serial port adapter 
(item # 3661USB) is the best option.  The adapter requires a driver to be installed on 
your machine and will work out of a different Com Port than the RS-232 port.  
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2.1 Preferences2.1 Preferences2.1 Preferences2.1 Preferences    

Preferences must be specified when the software is first installed to allow the 
computer, the software and the data logger to work together harmoniously.  The 
Preferences screen can be accessed from the File Menu option (See p. 13).  The 
Preferences screen is divided into 5 separate tabs: General, Communications, Data 

Storage, Graph and Monitor. 

General 

Units  

Allows you to choose whether data 
output is in English or metric units.  

Degree Day Calculations 

The degree day calculation method 
specified here will be used in the 
reports and the insect and disease 
models.  The Actual Degree Day 
Method calculates degree days using 
the temperatures from each logged 
interval.  The Single Sine Method 
applies a smooth sine curve to 
estimate degree days using the daily 
high and low temperatures.  The 
Growing Degree Day Method 
considers only the high and low 
temperatures for the day to compute 
the total number of degree days 
acquired.   (See Degree Days,  p. 
39) 

Location (for ET Calculation)  

The evapotranspiration algorithm incorporates specific information on weather station 
location.   Enter latitude and altitude information in the appropriate boxes.  Integer 
values of latitude and longitude will give sufficient accuracy. 

Growing Season Begins in Month 

SpecWare allows you to produce graphs and reports at the user-defined beginning of 
the growing season.  To correctly compute reports for an entire growing season, it 
must also know whether or not the season spans 2 calendar years.  This is relevant 
mainly for growers in the southern hemisphere.  Entering the month when the growing 
season begins allows SpecWare to make any necessary adjustments. 

Date and Time Display 

The date/time displayed on graphs can be in U.S. or international format.  24- and 12-
hour clock format must be selected as well as whether the date will be shown in 
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standard format or as a Julian Date. 

Language 

If the Spanish-language version has 
been activated, the language option to 
be used is selected here. 

Communication 

Direct Connection 

Allows you to select the port that 
SpecWare will use to communicate 
with the logger. It also allows you to 
test the connection to a 2000-Series 
logger.  You must select the 
communications port connected to your 
serial cable (See Testing the Com 

Port, p. 6). 

Wireless 

Allows you to select the port that 
SpecWare will use to communicate 
with a WatchDog Weather Station 
connected via a wireless connection.  In most cases, this will be the same port that 
connects to the gray direct connection cable.   

Modem Dial-Out 

If you are connecting to the weather station via telephone, the Port field is used to 
select the Com Port associated with your computer’s internal modem.  The Modem 
Initialization String field is set to a common default string.  Two of the more complete 
sites on the internet for modem information (including initialization strings) are 
www.modemhelp.org or www.modemhelp.net.  Please reference these for other 
brands if the default string does not help.   

Specify whether dialing is via touch-tone or pulse. Touch-tone is generally the correct 
option, though some phone systems use pulse dialing to minimize costs.  If you hear a 
long series of clicks after dialing, you will need to specify “pulse” dialing. 

The Wait after Connect time should generally be left as zero (the default).  If the 
modem seems to connect, but the weather station connection fails, try setting the delay 
to 1 (second) to allow the modems time to finish handshaking before they are asked to 
transmit data. 
 

 

Download Options 

Allows you to specify how the software handles the data download from the WatchDog 
loggers or shuttle (See Downloading Original WatchDog Data Loggers, p. 22).  The 
options are Normal, Auto Download for Shuttles only or Auto Download for all 
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loggers.  The Auto Download options retrieve the data from the loggers or shuttle and 
automatically save that data to the appropriate, already-created Logger Location(s) 
(See pp. 27 and 29).  By checking the Auto Relaunch after Auto Download box, the 
software will automatically relaunch your logger after the automatic download.  The 
previously used name and recording interval are retained during an automatic launch.  

All Auto options proceed without user intervention. 

NOTE:  It is recommended that you choose Normal and confirm each step of the 
download, save, and relaunch process until you are familiar with how the software 
manages the data and the data logger.  This option does not apply to 2000-series 
loggers. 
 

 

Com Port Open 

The power-saving features on some PCs (especially laptop computers) will power 
down the serial port until it is needed.  The delay in the power-up can hinder 
SpecWare’s ability to communicate through the Com Port.  The Always option tells 
SpecWare to open the serial port and keep it open until the software is closed.  This 
option, however renders the Com Port unavailable for Alert and AutoDownload 
functions until SpecWare is shut down.  This situation is remedied by selecting the 
Fast or Pause options.  For PCs that do not have energy-saving features, the Fast 
option tells SpecWare to immediately begin communication through the Com Port as 
soon as it is opened.  The default option, Pause with a delay of 1 second, provides a 
compromise solution with minimal delay while still functioning properly on almost all 
PCs.  The number of seconds to 
pause can be changed if necessary. 

 

Data Storage 

Data Folder Location 

Initially displays the directory where 
SpecWare was installed and where 
Logger Location directories are 
being saved.  The default storage 
location is in the SpecWare directory.  
This screen also allows you to specify 
whether or not data can be saved to 

diskettes (See Saving Data, p. 29). 

Data File Locations 

In this section, you can decide 
whether or not to limit the length of 
Logger Location names.   
 

Palm Shuttle Hotsync File Location 

When a Palm Pilot is used to download loggers in the field, SpecWare will remember 
the first location where Hotsync files are stored.  If you want to change the Hotsync file 
storage location, press the Reset Location button and enter the new location in the 
field.  Check the box if you want these files automatically deleted after they have been 
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imported.  Deletion will prevent files 
from being imported multiple times 
to SpecWare. 

Graph 

Data Redisplay Intervals 

A Default Interval can be specified 
when displaying a graph from saved 
data files (the initial default is 60 
minutes).  SpecWare can graph a 
maximum of 8000 points, and the 
interval between data points 
depends on the time period 
displayed. A Minimum Interval can 
also be specified (the initial default is 
15 minutes).  This should be set to 
match your normal logger recording 
interval.  Setting the Minimum 
Interval to the interval at which data 
was recorded prevents SpecWare 
from graphing more data points than you actually measured.   

For example, using data that was recorded every 30 minutes to create a graph that has 
a 15 minute Minimum Interval will cause SpecWare to display two points on the 
graph, 15 minutes apart, to represent the single recorded data point.  In this case, 
specifying a 30 minute Minimum Interval will make the graph and text data display 

match your recorded data.  (See View and Print Menus, p. 32) 
 

Initially Display 

In this section, the user can select the 2 default parameters that are automatically 
graphed.  If nothing is checked then the user must select the parameters to be graphed 
every time a file is opened. 

 

Within Intervals 

If the redisplay interval is longer than the measurement interval, SpecWare can display 
the mean value of all included data points (Display Mean) or the actual data point 

closest to each of the given time points (Display Closest). 

 

Limits 

For each graphed parameter, the user can specify the data range for the vertical axis.  
By default, the software will set the range based on the maximum and minimum values 
in the data set.  But, for example, it may be desirable to have the horizontal axis pass 
through zero rather than the minimum data value.  To set a maximum or minimum, 
select parameter of interest from the menu, enter the desired values and click the 

Change button. 
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Appearance 
 

Show X (Vertical) grid lines 

This will cause vertical lines to appear on the graph at regular intervals. 
 

Show Y (Horizontal) grid lines  

This will cause horizontal lines to appear on the graph at regular intervals. 
 

Show Both X and Y Cursor Lines  

Checking the box will add a horizontal tracker bar to the graph when it is displayed 

(See View and Print Menus, p. 32). 
 

Mark Points on Printed Graphs  

If this box is checked, SpecWare will put individual data points onto the graphed line.  

 

Monitor 

This screen is used to configure 
your computer to automatically 
read and process a  weather 
station’s current conditions.   This 
feature uses the Windows 
AutoScheduler and requires 
Windows 2000 or greater to run. 

Weather Station Real Time 

Monitor 

Weather stations with continuous 
direct connections have the ability 
to create a separate log file using 
the Weather Monitor Program.  
This file is separate from the data 
recorded in the data logger.  This 
program will only log while the 
Weather Monitor Program is 

running. (See Scheduled Features manual for more details) 

 

Monitor Log and Web output 

SpecWare 7 can regularly update  the current weather conditions on a user’s web 

server.   (See Scheduled Features manual for more details) 
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2.2 Toolbar2.2 Toolbar2.2 Toolbar2.2 Toolbar    

After starting SpecWare, the menu bar will initially offer File, Logger and Help menu 
options.  The quick-buttons, from left to right, are Exit SpecWare, Open File, Save 
Logger Data, WatchDog Manager, Launch WatchDog Logger, Readout 
WatchDog, and Weather Station Monitor, and specify Large/Small Toolbar 

Buttons.   

After a file is opened or a logger is downloaded, the Edit, Print, View and Tools menu 
options will appear and the View Data as Text and Change Graph Parameters quick-
buttons will be activated.   

Two additional quick-buttons, Reset Zoom and Zoom Out, will be activated if the 
graph zoom feature is used (see pp. 39-40). 
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Open File: Allows the user to open previously saved data files.    
 

Save File: Allows the user to save data to a Logger Location if one is not chosen 
immediately after downloading a datalogger.  
 

Import Files: 
 

♦ Importing PDA Shuttle File: Allows the user to import data files collected remotely 
by a portable, handheld computer.  Contact Spectrum Technologies for information 
obtaining the software required for this option. 

 

♦ Importing Raw Data File: Imports and interprets data files collected using 
SpecWare diagnostic tools.  

 
♦ Convert SpecWare v 3-6: Converts data from SpecWare versions 3 through 6 to a 

format usable in SpecWare 7.  (See Converting Archived Data into SpecWare 7 
Format pg. 30) 

 
♦ Import Generic Weather Data Files: This option allows you to import data files 

created by other weather collecting systems.  
 
♦ Import WeatherLink Data Files: This option imports data collected using Weather-

Link Software.   
 

Preferences: Allows the user to select various graph, communication, data storage, 

and general configuration options (see Preferences p. 7) 
 

Exit: This terminates the SpecWare session. 

2.3 File menu2.3 File menu2.3 File menu2.3 File menu    
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Introduction 

The WatchDog Manager screen is brought up with the quick button on the SpecWare 
toolbar (see Toolbar, p. 12) or from the Logger menu (p. 21).  SpecWare 7 Pro soft-
ware divides the WatchDog family of data loggers into 3 categories; 1.) 2000-Series 
data loggers, 2.) Original WatchDog loggers (100/200/400 series mini data loggers and 
525 - 900ET weather stations), and 3.) Button loggers.  For the sake of brevity, in this 
section, the term “station” will refer to all types of WatchDog products unless a specific 
type of WatchDog data logger is being referred to explicitly.  The WatchDog Manager 
screen can be used with all 3 types of logger but it must be used for all communica-
tions with the 2000-Series data loggers.  It must also be used when communicating 
with a remote weather station via a telephone modem or with multiple stations con-
nected via a wireless multi-point setup.  This screen allows you to download and re-
launch a specific station as well as add and delete a station to your network. 

It is possible that you will have Logger Locations available in SpecWare that don’t ap-
pear in the WatchDog Manager screen.  The WatchDog Manager screen is only 
used to communicate with stations.  It is not used for viewing existing data files (See 
Opening Files, p. 28).  Deleting a station will have no effect on data that has already 
been downloaded and saved from that station.  Likewise, establishing a new station 
will not automatically create a Logger Location.  A Logger Location will be created 
when that station is first downloaded. 

3.1 WatchDog Manager3.1 WatchDog Manager3.1 WatchDog Manager3.1 WatchDog Manager    

Figure 1 
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Generic Station Options 

The last 3 options in the WatchDog Manager screen’s list of stations are generic op-
tions.  The generic options are shown in parentheses.  They do not refer to a specific 
station but rather to each of the 3 logger categories (2000-Series, Original, and But-
ton).  The generic option allows you to establish contact with a station even if you don’t 
know its name.  After selecting a generic option, you can then perform any operation 
available for that logger type.  SpecWare is able to read the name of the station from 
its electronic header and carry out readout, relaunch and reconfiguration operations as 
if that station had been selected explicitly from the list of available stations in the 
WatchDog Manager screen (see Fig. 1).  If you are downloading a station whose 
name is not on the list of stations, SpecWare will ask if you want to add that station to 
the list. 

WatchDog Manager Toolbar Buttons 

New Station 

The New Station button is used to add stations to the list of available stations.  After 
clicking this button, a blank WatchDog Properties screen will appear (see Properties 
section below for details). 

Delete Station 

This button allows you to delete an existing station from the list of available stations.  
Even after a station has been deleted, data downloaded from that station will be avail-

able from the SpecWare Logger Location directory. 

Autodownload Scheduler 

This button allows you to bypass the WatchDog Properties screen and go directly to 

the AutoDownload Scheduler screen (see Scheduled Features manual). 

Get Current Conditions 

This option will bring up the WatchDog Real-Time monitor (see Real-Time Monitor, p. 
25).  This option is only available for WatchDog weather stations and 2000-Series data 
loggers that are in contact with the PC via a direct-, radio- or telephone connection.  
This option is grayed out for WatchDog button loggers. 

Relaunch Only  

Click this option if you want to launch a station without first downloading the data.  This 
option may be desirable if the station is being put back into service after a period of be-
ing idle.  The station will be launched with the same configuration it had the last time it 
read data.  This option is grayed out for the 2000-Series data loggers because their 
data logging function is not interrupted by a download so the station never needs to be 
relaunched.   
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Readout or Readout and Relaunch 

This button is used to download data from a station.  For Original and Button-style 
WatchDog data loggers, this option will appear as Readout and Relaunch.  For the 
2000-Series data loggers, this option will appear as Readout.  The data is saved to the 
Logger Location that matches the logger name.  If this location does not exist, 
SpecWare will prompt you before creating it.  Original and Button-style loggers are re-
launched with the same configuration they had when they were downloaded.  With the 
WatchDog Manager, it is not possible, during the download process itself, to create a 
new location where data should be saved.  Data will always be saved to the location 
defined by the station name. 

Exit 

Exits the WatchDog Manager screen. 

Properties 

The Properties button brings up the WatchDog Properties screen.  This screen is the 
gateway to all the WatchDog Manager configuration functions.  It is used to configure 
a new station or to edit the configuration of an existing station.  No configuration 
changes on this partial screen will be transferred to the station until the fully expanded 
WatchDog Properties screen (see More button) has been brought up and the OK 
button has been pressed.  The options for this screen are described below. 

 

Logger/Station Name  

Enter the name of the Logger Location where data will be saved.  When creating a 
new station, this field will initially be blank.  A name can only be entered for new sta-
tions.  The name of an existing station cannot be changed.  To change the name of an 
existing station, a new station must be created with the new name.  This name will  
then be transferred to the logger header.  Caution must be exercised when changing 
the name of an existing station because all subsequent downloads of the station will be 
saved to a new Logger Location and it is possible to erase all data on the logger (see 
Clearing Data from a 2000-Series Data Logger, p. 18).  The Logger Location asso-
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ciated with the old station name will still be visible in the list of available stations.  If the 

name change is permanent, this old station (not the Logger Location) can be deleted.    

WatchDog Type and Connection Type  

Select the appropriate options on this screen.  For Original and Button loggers, 
changes in logger configuration can only be performed with loggers that are directly 
connected.  2000-Series loggers can be reconfigured through phone or radio connec-
tions as well.  Configuration of remote stations can be most easily handled by directly 
connecting them to the PC and using the Generic Direct-Connect options (See Ge-

neric Station Options p. 15) That way the existing connection info is not changed. 

Number  

If you are using a dial-out modem, enter the phone number in the text box.  When en-
tering a telephone number, be sure to include any additional, preceding digits required 
by your phone system.  When using the wireless transceivers, enter the radio address 

in the Number text box.  

AutoDownload Schedule button  

Brings up the AutoDownload Scheduler screen (see Scheduled Features manual).    

Alert Schedule button 

Brings up the Weather Station Alert Configuration screen (see the Scheduled Fea-

tures manual).   

More button 

Clicking the More button causes SpecWare to initiate communication with the station.  
The WatchDog Properties screen is then expanded to display specific details about 
the station’s logging configuration (see Launching/Configuring Stations with the 
WatchDog Manager, p. 19).   The expanded screen can only be brought up when a 
station is connected to a PC.  An Original or Button logger cannot be configured or 
launched with a radio or telephone connection. 
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3.2 Clearing Data from a 3.2 Clearing Data from a 3.2 Clearing Data from a 3.2 Clearing Data from a     

2000200020002000----Series Data LoggerSeries Data LoggerSeries Data LoggerSeries Data Logger    

Data is not routinely erased from 
the memory of a 2000-Series data 
logger.  The only way to clear the 
data from memory is by changing 
the Station Name in the Watch-
Dog Properties screen (See 
WatchDog Manager, p. 14).  This 
is done by connecting the logger 
to the PC and creating a new sta-
tion with a different name.  Click 
on the “More” button.  This will 
bring up a warning message (fig. 2).  

After clicking the Yes button, a warning message (fig. 3) will appear informing you that, 
if the data is not erased, future downloaded data will be saved to a different Logger 
Location. After clicking the OK button, a final warning message (fig. 4) appears that 
asks you whether you want to delete all data from memory or not.  Clicking the Yes 
button will prepare SpecWare to send the “Clear Data” instruction to the data logger.  
After clicking the Yes button, SpecWare will return to the WatchDog Properties 
screen (see p. 15).  Hitting the Cancel button on that screen will disallow the erasure 
process.  Hitting the OK button will cause the logger to erase itself.  The process will 
take several minutes and, at this point, cannot be reversed.  It is not necessary for the 
logger to be connected to the computer once the erasure process has begun.  

Figure 2 

 

Figure 3 

Figure 4 
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3.3 Launching/Configuring Stations3.3 Launching/Configuring Stations3.3 Launching/Configuring Stations3.3 Launching/Configuring Stations    

with the WatchDog Managerwith the WatchDog Managerwith the WatchDog Managerwith the WatchDog Manager    

WatchDog 2000-Series data loggers can only be re-configured through the WatchDog 
Properties screen of the WatchDog Manager.  These loggers are not launched and 
relaunched like the original WatchDog data loggers.  Original WatchDog data loggers 
and weather stations can be launched through the WatchDog Manager as well as 
through the logger menu or toolbar quick buttons (see Launching Original Loggers, 
p. 23).  The WatchDog Manager screen is brought up with the quick button on the 

SpecWare toolbar (see Toolbar, p. 12) or from the Logger menu (see p. 21).  

Note: The appearance of this screen will depend on the type of logger connected. 

Configuring/Launching a Station 

Original and Button stations can only be reconfigured when the station is connected to 
the PC with the gray PC interface cable, direct-connect cable or short-range modem 
pair.  The WatchDog Manager uses the old launch process to change the logger’s 
properties.  2000-Series loggers can be configured with any connection type.  Bring up 
the WatchDog Manager screen, select the station of interest (or the appropriate ge-
neric option), and click the Properties button.  This will bring up the WatchDog Prop-
erties screen.  Click the “More” button at the bottom of the screen.  This will expand 
the screen to display the entire configuration of the station.  The various fields are de-
scribed  on the following pages. 

Sample WatchDog Properties screen (fully expanded) for a 2000-Series logger 
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Data Collection Interval 

The data collection interval is the amount of time that elapses between measurements.  

Report (2000-Series only) 

The LCD can be programmed to display additional calculated parameters by selecting 
that parameter from the dropdown menu of the WatchDog Properties screen.  The 
Plant Growth report requires PAR light and air temperature sensors.  The Heating De-
gree Day report requires an air temperature sensor or an external temperature sensor 
on channel D (model 2400 only).  If you have purchased optional disease models for 
SpecWare, the dropdown menu in the Report section will show these options as well.  
For Original data loggers, this feature will be grayed out.  The model, serial and firm-
ware number for the logger appear to the right of the dropdown menu field. 

Sensor/Units 

These boxes allow you to select which parameter each external channel will measure.  
Click on the arrow to display the list of possible parameters.  Rain gauges connected to 
external channels of the mini- and 2000-Series data loggers must be assigned to Port 
A.   

NOTE:  There are several different soil moisture sensors that can be connected to 
WatchDog data loggers.  Ensure that the appropriate type of soil moisture sensor has 
been selected.   

Update 

While connected to the computer, the Update button will instruct the logger to take a 
reading.  It will take about 2 seconds for the reading to appear.  If no sensor is con-
nected to a particular port, “N/A” will appear for that port.  With the exception of the 
Button loggers, the battery status will also be displayed.  The battery should be re-
placed when battery power drops to 25%. 

Wrap Around 

In the Wrap around when full box, you can determine how data will be handled if the 
logger is not downloaded before it reaches its data holding capacity.  Click in this box if 
you want the logger to write over the oldest data and continue reading new data.  For 
example, if you launch for a 30 day duration, but do not recover the logger until much 
later, the data will reflect the most recent 30 days.  If Wrap around when full is not 
checked, the logger will turn itself off when it is full and await recovery and readout.  
Wrap Around is always enabled for the 2000-Series data loggers.   

Delayed Start 

This option is only available for mini data loggers and Button loggers.  It allows the log-
ger to begin logging at a later, pre-specified time (up to 45 days after launching your 
logger).  Insert the date in the first box.  Insert the starting time in the next box.  The 
date/time formats should match the format selected in Preferences.  For loggers with 
an LCD display, the letter “d” will appear followed by the number of minutes until 
launch.  Loggers with an LED will flash dimly every four seconds until the delay has 
expired and the logger begins logging.   
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Alarm 

This option is only available for Weather Stations and 2000-Series data loggers.  The 
Alarm feature works with the Alarm Output Module.  Select the desired channel or pa-
rameter in the first field.  A target value is entered into one or both of the other 2 fields 
to indicate whether an alarm is triggered if the measured value goes Above or Below 
the target value.  Original weather stations allow only one target value.  2000-Series 
loggers allow upper and lower alarm thresholds.  See the Alarm Output Module 

User’s Guide for more details. 

3.4 Logger Menu3.4 Logger Menu3.4 Logger Menu3.4 Logger Menu    

WatchDog Manager 
This option brings up the WatchDog Manager screen (see WatchDog Manager p. 
14).  This screen must be used for communicating with 2000-Series data loggers.  It 
can also be used to readout and relaunch Original and Button loggers. 

 
Launch WatchDog 
This establishes a connection with a WatchDog Original or Button logger and displays 
the Launch Options screen.  This option is equivalent to clicking on the Launch 
WatchDog Logger quick-button on the toolbar (See Launching Original Data 

Loggers, p. 23). 

 

Get WatchDog Data 
This establishes a connection with the logger and downloads the data  accumulated 
since the logger was last launched.  This option is equivalent to clicking the Get 
WatchDog Data quick-button on the toolbar (See Downloading Original Data 

Loggers, p. 22). 

 

Weather Station Real-Time Monitor 
This launches the Weather Monitor screen (See p. 25).  This is equivalent to the 
Weather Station Monitor toolbar button.  This option will not activate the real-time 
monitor for a 2000-Series data logger. 
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3.5 Downloading Original 3.5 Downloading Original 3.5 Downloading Original 3.5 Downloading Original     

WatchDog Data LoggersWatchDog Data LoggersWatchDog Data LoggersWatchDog Data Loggers    

WatchDog mini data loggers and weather stations can be downloaded with the Watch-
Dog Manager (see p. 14) or with the Quick Button on the SpecWare toolbar (see p. 
12).  The Quick Button download procedure is described below.  2000-Series loggers 
can only be contacted via the WatchDog Manager.   

 

Before downloading data, you must establish a connection between the data logger 
and your computer.  For mini data loggers and data shuttles, this is done with the gray 
serial cable.  For the WatchDog button loggers, use the docking station.  For weather 
stations, a connection can be made with the gray cable, a 100- or 200-ft direct connect 
cable, a short-range modem pair, a remote wireless connection or with a landline or 
cellular telephone connection. 

Click the Get WatchDog Data quick-button or Get WatchDog Data from the Logger 
menu to contact the WatchDog and initiate the download sequence.   

As the logger is downloading, a SpecWare Progress dialog box will be visible.  When 
the data transfer is complete, a dialog box will appear indicating that readout and 
translation is complete.  You may then disconnect the logger from the serial cable.   

SpecWare will automatically prompt you to save the logger data (See Saving Data, p. 
29).  All new dataloggers require that you create a new Logger Location the first time 
the logger is read out.  Once this Logger Location is established, subsequent logger 
data readouts can be appended to this Logger Location.  For weather stations con-
nected via telephone modem or a multi-point wireless system, the data will automati-
cally be downloaded into the Logger Location with the same name entered in the ID/
Location Name field of the logger header (See Launching Original Data Loggers, p. 
23) or the name given to it when it was created in the WatchDog Manager screen 

(see WatchDog Manager, p. 14). 

After downloading WatchDog loggers, SpecWare will display a screen (see Opening 
Files, p. 28) that allows you to select which parameters will be graphed as well as on 
which vertical axis the data scale for a given parameter will be displayed.  Up to 2 pa-
rameter types can be selected and all data files of that type will be displayed.  The data 
will be displayed in a graph with the logger reading on the vertical scale and time on 
the horizontal scale.   

IMPORTANT:  Until the logger is relaunched, the data remains on the logger and can 
be downloaded again.  Once you have retrieved data, you must relaunch the logger to 
continue making measurements.  Clicking Start to relaunch the logger erases the pre-
viously recorded data from the logger. 
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3.6 Launching Original 3.6 Launching Original 3.6 Launching Original 3.6 Launching Original     

WatchDog Data LoggersWatchDog Data LoggersWatchDog Data LoggersWatchDog Data Loggers    

WatchDog mini data loggers and 
weather stations can be launched with 
the Quick Button on the Specware 
toolbar (see p. 12).  The Quick Button 
launch procedure is described below.  
2000-Series loggers can only be 
contacted via the WatchDog Manager 

(see WatchDog Manager p. 14). 

 

Initiating Contact 

With the logger connected to the 
interface cable, initiate the launch 
process by using the Logger menu or 
by clicking the Launch WatchDog 
Logger quick-button (See p. 12). The 
Launch Options screen will appear.  
Initially, the screen will display the current launch configuration.  Any of the launch 
configuration parameters can be changed except whether the data is output in English 

or metric units (See Preferences, p. 7).    

To launch the logger, click on the Start button.  When the logger is actively reading, 
the LCD will indicate the logger status.  On loggers lacking an LCD, a red LED will 
flash.  (It will flash only dimly every four seconds during the delay period of a delayed 
launch.)  Click the Cancel button to exit the Launch Options screen without launching 
the logger. 

CAUTION:  Clicking the Start button erases previously recorded data from the logger.  

Until Start is clicked, that data is available for download. 

NOTE: Do not unplug the logger from the interface cable until SpecWare has indicated 
that the launch has been completed.  

 

Launch Options Screen  

Header 
The top field of the dialog box gives a description of the logger and its serial number.  
Neither the description nor the serial number can be changed.  The header will also 
show the current date and time on your computer.  This information will be transferred 
to the logger when it is launched. 
 

ID/Location Name 
The text in this box can be used to identify the Logger Location.  Up to 40 characters 
can be written in this area.  The logger location entered will become the default 
location for saving the data. 
 

Sample Launch Options screen 
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Measurement Interval and Maximum Duration 
The interval is the amount of time that elapses between measurements.  After 
selecting the interval, the maximum duration (time it will take to completely fill the 
logger) is calculated and displayed by SpecWare. 
 

Port Enabled 
On the WatchDog Data Loggers you can enable or disable the ports by checking or 
unchecking the appropriate boxes.  For WatchDog weather stations, only the external 
channels can be disabled.  The sensors that come standard (including the solar 
radiation sensor on the 900ET station) are always enabled. 
 

Sensor/Units 
These boxes allow you to select which parameter each logger channel will measure.  
Click on the arrow to display the list of possible parameters.  Rain gauges connected to 
external channels of the mini data loggers must be assigned to Port A.   
 

NOTE:  There are four different soil moisture sensors that can be connected to 
WatchDog dataloggers.  Ensure that the appropriate type of soil moisture sensor has 
been selected.   
 

Update 
While connected to the computer, the Update button will cause the logger to take a 
reading.  It will take about 2 seconds for the reading to appear.  If no sensor is 
connected to a particular port, “N/A” will appear for that port.  For the WatchDog 
(except model 100), the battery status will also be displayed.  The battery should be 
replaced when battery power drops to 25%. 

Alarm 
The Alarm feature is only active with Weather Stations connected to an Alarm Output 
Module.  Select the desired channel or parameter in the first field.  Indicate in the 
second field whether the alarm module is triggered when the measured parameter 
Goes Above or Goes Below the target value entered in field 3.  See the Alarm 

Output Module User’s Guide for more details. 

Wrap Around 
In the Wrap around when full box, you can determine how data will be handled if the 
logger is not downloaded before it reaches it’s dataholding capacity.  Click in this box if 
you want the logger to write over the oldest data and continue reading new data.  For 
example, if you launch for a 30 day duration, but do not recover the logger until much 
later, the data will reflect the most recent 30 days.  If Wrap around when full is not 
checked, the logger will turn itself off when it is full and await recovery and readout. 

Delayed Start 
The Delayed Start box will appear for those loggers that are capable of using this 
option.  It allows the logger to begin logging at a later, pre-specified time (up to 45 days 
after launching your logger).  Insert the date in the first 3 boxes in the format mm/dd/
yyyy.  Insert the starting time in the next 3 boxes.  For loggers with an LCD display, the 
letter “d” will appear followed by the number of minutes until launch.  Loggers with an 
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LED will flash dimly every four seconds until the delay has expired and the logger 
begins logging.  The time uses a 12-hour format; you must enter “am” or “pm”.   

NOTE:  WatchDog Weather Stations are not capable of using the Delayed Start 
feature. 

3.7 Real3.7 Real3.7 Real3.7 Real----Time Weather MonitorTime Weather MonitorTime Weather MonitorTime Weather Monitor 

WatchDog Original Weather Stations  

The first launch of a station will enable the Weather Station Real-Time Monitor option 
in the Logger menu and the Weather Station quick-button on the SpecWare 7 Pro 
Toolbar screen (see p. 12).  Clicking either the menu option or the quick-button will 
display the one of the first two monitor screens shown on p. 26.  (Note: once the 
Weather Station Real-Time Monitor is initialized, SpecWare 7 Pro does not have to 
remain open to display the monitor screen.)  The monitor screen displays the current 
weather conditions including readings from the sensors that are plugged into the 
external ports of the weather station. 

IMPORTANT:  For the Real-Time Weather Station Monitor to work correctly, the 
weather station must be connected to the computer using the optional hardwire or 
remote PC connections. 

 

The data on the monitor screen is updated by clicking on the Refresh button on the 
lower left part of the screen.  Clicking the Repeat Refresh button will cause the 
monitor screen to update every five minutes. 

The amount of Rain since the last download/launch and current Rain amount since the 
last Reset are displayed on the lower right corner of the monitor screen.  There may be 
several rainfall events between the times that data is downloaded to the computer (see 
Downloading Original Data Loggers, p. 22).  Click the Reset Rain button to zero the 

currently accumulated Rain amount. 

The bar graph is composed of Air temperature, Dew point and wind Chill.  The green 
and blue horizontal lines on the bar graph are the daily high and low temperatures 

 

2000-Series Data Loggers 

The monitor screen for the 2000-Series loggers can only be activated by clicking the 
Get Current Conditions option in the WatchDog Manager.  A sample screen is 
shown on p. 26. 

 

Note:  If SpecWare cannot make a connection when trying to bring up the Real Time 
Monitor, the user may need to end the task (SpecWSM7) in the Task Manager.  You 
can bring up the Task Manager by simultaneously clicking the Cntrl-Alt- Delete buttons 
on the keyboard. 
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Monitor Screen for a 

Model  800 station.  Cur-

rent values for each of the 

8 sensors, the battery 

strength, and the time are 

displayed.   

Monitor Screen for all 

Original stations ) except 

the model 800). 

Monitor Screen for a 2000-

series logger. 
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4.1 Data4.1 Data4.1 Data4.1 Data M M M Managementanagementanagementanagement    

SpecWare offers significant advantages in data information management and decision-
making tools.  SpecWare simplifies your database with Logger Location directories.  
This permits easier analysis of trends and historical data.   

The database is the permanent record of data stored on your hard drive.  When you 
download the logger, SpecWare transfers all information in the logger memory to the 
computer and you have the option of saving to an existing Logger Location.  For 
Original WatchDog data loggers and weather stations, it is also possible to create a 
new location to save the logger data.  Suggestion:  Use the “ID/Location Name” box 
that appears in the logger “Launch Options” screen as your Logger Location (e.g. 
North Orchard).  Each Logger Location in SpecWare is a subdirectory in 
C:\Specware.  If you choose to save your downloaded logger data to a floppy diskette, 
it is important to use a separate floppy diskette for each location because of the way 
data files are built by SpecWare. 

The software stores data to disk in monthly files.  All parameters are recorded in the 
same file in a subdirectory named for the Logger Location.  As new data is 
downloaded from the logger, it is appended to the appropriate month for the location 
you have specified.  The name of the data file indicates the year and the month of the 
data.  For example, SD200602.swd is the data for February 2006.  Each Logger Loca-
tion directory must contain an index file (index.swd).  This index file is used by 
SpecWare to identify which parameter is associated with each column in the data files.  
For this reason, care must be exercised when transferring or copying data files from 

one Logger Location to another. 

CAUTION: The files in each Logger Location are given the same names as those in 
other Logger Locations.  Therefore, it is important to carefully choose the Logger 
Location when adding new data to existing locations or to floppy diskette to avoid 
mixing the data from separate locations. 
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4.2 Opening Files 4.2 Opening Files 4.2 Opening Files 4.2 Opening Files     

Open File 
Click the Open Logger File(s) toolbar button or the Open File option from the File 
menu to bring up the Open Logger Files screen. From the upper box, select the 
Logger Location where the file is located. Data files saved on a floppy disk can also 
be retrieved (A: drive).   
 
Data Redisplay Options 
SpecWare offers 3 data redisplay options.  These options are shown in the Select 
Time Period to Display field in the lower right corner of the Open Logger Files 
screen. 
 
The first option allows you to view only the most recent data in the selected Logger 
Location.  Enter the time interval of interest in the two text fields.  The dropdown menu 
allows for time increments of days, weeks, or months.  It is possible to exclude the 
current week or month of data.  This may be desirable if the data has just been 
downloaded or if you want to look at data from the last complete time interval. 
 
The second option instructs SpecWare to display all data from the beginning of the 
growing season defined in the General tab of the Preferences screen (see p. 7). 
 
The third option allows you to select a specific range of months.  The months are 
selected from the list in the lower left corner of the Open Logger Files screen.  
Multiple months can be selected by holding down the left mouse button and dragging 
the cursor or by selecting the first month and, while holding the shift key, selecting the 
other months with the arrow keys.   
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The third option is SpecWare’s default mode.  One of the 
other options can be set as the default by clicking the box at 
the bottom of the screen.  The newly selected default setting 
will not be universal but will only apply to the specific Logger 
Location for which it has been selected. 
 

After selecting the Logger Location and data redisplay 
interval options, clicking the Open button will bring up the 
Change Graph Parameters screen (shown to the right).  
This screen allows you to select which parameters will be 
graphed as well as on which vertical axis the data scale for a 
given parameter will be displayed.  Up to 2 parameter types 
can be selected and all data files of that type will be 
displayed.  The data will be displayed in a graph with the 
logger reading on the vertical scale and time on the horizontal 

scale.  (See View and Print Menus, p. 32). 

4.3 Saving Data4.3 Saving Data4.3 Saving Data4.3 Saving Data    

Data downloaded from 2000-Series loggers is automatically saved to a Logger 
Location  with the same name as the Logger/Station Name assigned in the Proper-
ties screen (see WatchDog Manager, p. 14). 
 
Saving Files Downloaded from Original WatchDog Stations 
When you download the data from an original 
logger, the Save Logger Data box will 
appear.  Choose the directory where you want 
to save the file. You may append the data files 
into an existing Logger Location, save them 
to a newly created Logger Location, or save 
to a floppy disk.  If you decide to create a new 
location, you will be prompted to name this 
location.  Generally, the data will be saved to 
a logger location in the SpecWare directory on 
the drive where the software was installed.  
Files can also be saved to the floppy disk drive (A: or B: drive) if this option is selected 
in the Data Storage tab of the Preferences screen (see pg. 15).  If you choose to not 
save your data at this time, click on the Cancel button to go directly to the graph 
screen.  You can save the data later by selecting the Save File option from the File 
menu.  Otherwise, you will be reminded to save the file if you attempt to open another 
file or exit from the program.  
 

Using Your Data in Other Applications 
SpecWare creates an ASCII file for use in other applications as soon as a download 
file is saved.  The file is tab-delimited for use in spreadsheets, word processors and 
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4.4 Converting Archived Data into 4.4 Converting Archived Data into 4.4 Converting Archived Data into 4.4 Converting Archived Data into 

SpecWare 7 Format SpecWare 7 Format SpecWare 7 Format SpecWare 7 Format  

The data files used in SpecWare 7 differ from 
those in earlier versions of the software.  Instead 
of having a unique monthly data file for each pa-
rameter, all data collected in a given month is in-
cluded in one master data file.  This file has a .swd 
extension associated with it.  An index.swd file is 
also included in the Logger Location folder to al-

low SpecWare to process these data files into reports and graphs. 

Data files created in earlier versions of SpecWare can be converted into the file format 
used by SpecWare 7.  Select Convert SpecWare v3-6 Files from the Import Files 
menu within the File menu (Fig. 5). This will bring up the file conversion screen (Fig. 
6).  All Logger Locations from the SpecWare directory will be visible.  Select the loca-
tion that contains the data you wish to convert.  By default, every month of data will be 
converted.  If you wish to only convert certain months of data, check the Convert Spe-
cific Month(s) box and use the mouse 
to select the desired months. 

Click the Convert button to initiate the 
conversion. SpecWare will create the 
new data files and the index.swd file.  
The new data files are added to the di-
rectory and the old data files are left in-
tact.   

Note: If the index.swd file is removed, 
SpecWare will automatically recreate it 
the next time that Logger Location is 
opened. 

Figure 5 

other applications.  These raw data files are located in the SpecWare directory in a 
folder named for the Logger Location. 
 

IMPORTANT: All new dataloggers require that you create a new Logger Location. 
Once this Logger Location is established, subsequent logger data readouts can be 
appended to this Logger Location. 

Figure 6 
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4.5 Importing Data4.5 Importing Data4.5 Importing Data4.5 Importing Data    

There are several instances when it may be necessary to import data files into 
SpecWare.  All import functions are accessed from the Import Files option in the File 
menu (see p. 13).  After the files to be imported have been selected, the Save Logger 
Data box will appear.  If more than one file has been selected, each file will be im-
ported in succession.  You may append the data files into an existing Logger Loca-
tion, save them to a newly created Logger Location or onto a floppy disk (see Saving 
Data p. 29).  The various input options are listed below. 
 

Importing .wdr Files 
 
Palm/PDA Files 
Files that have been transferred to a PC from a Palm Pilot or other PDA device must 
be imported into SpecWare.  Select Import PDA Shuttle File from the Import Files 
dropdown menu.  This will bring up a screen that allows you to browse to the location 
of the saved data files.    
 

Raw Data Files 

Some files that have been created by using WDTest to extract raw data from a data 
logger or weather station may be imported directly into SpecWare.  This will not be 
possible if the files need to be repaired by Spectrum Technologies before they can be 
imported.  Select Import Raw Data File from the Import Files dropdown menu.  This 
will bring up a screen that allows you to browse to the location of the saved data files.   

 

Importing Weather Data Files 
 

WeatherLink Data Files 

SpecWare is able to import and process files that were initially downloaded with 
WeatherLink software.  These files will have a suffix of .wlk.  Select Import Weather-
Link Data Files from the Import Files dropdown menu.  This will bring up a screen 
that allows you to browse to the location of the saved WeatherLink data files.  

 

Note: WeatherLink considers midnight to be the last data point of the day.  SpecWare 
considers midnight to be the first data point of the day.  Therefore, if a WeatherLink file 
has a data point for midnight, SpecWare will create a SpecWare file for the same 
month, plus a file for the following month containing only the last midnight record. 
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Generic Weather Data Files 

SpecWare is able to import and process 
weather data files that were initially created 
with other data logging software.  The data 
must be text files in tab-delimited format. One 
line in the file must contain SpecWare-specific 
key words that identify which weather pa-
rameter is contained in each column of data.  
The date and time information must be in the 
first one or two columns.  Select the Import 
Generic Weather Data Files option from the 
Import Files dropdown menu.  This will bring 
up a screen that allows you to browse to the 
location of the saved weather data files.  Se-
lect one or more files and click Open.  In the SpecWare File Import Options screen, 
specify how the data file is configured.  This configuration can be stored as the default 
by clicking the Save as Default button.  Otherwise, click the OK button and proceed 
with saving the data in SpecWare.   

4.6 4.6 4.6 4.6 ViewViewViewView and  and  and  and PrintPrintPrintPrint  Menus  Menus  Menus  Menus    

Viewing Your Data as a Graph 
Upon downloading data or opening an existing file, select the parameters you wish to 
view.  SpecWare will display the Change Graph Parameters screen (see p. 29).  
Select which parameters will be graphed and on which vertical axis the data scale for a 
given parameter will be displayed.  Up to 2 parameter types can be selected and all 
data files of that type will be displayed.  The data will be displayed in a graph with the 
logger reading on a vertical scale, time on the horizontal scale and the legend shown 
underneath the graph.  As the cursor is moved across the graph, the time and data 
values are displayed at the bottom of the screen.   
 
Viewing Your Data as Text 
Click on the View Data as Text  quick-button or on 
the View Data as Text command in the View 
menu.  A WordPad or Notepad window (depending 
on what is available on your computer) will overlay 
the graph and display the numerical data for that 
graph.   
 
Printing Your Graph 
Click on the Print Graph command under the Print 
menu to print the graph displayed on the screen. 
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Printing Your Data as Text 
Click on the Print Text File command under the Print menu on the Graph/Data 
Screen to print the numerical data for the graph displayed on the screen.   

NOTE:  The data displayed using the View Data as Text or Print Text File commands 
may not always be the raw data as recorded by the data logger.  The data displayed 
has been adjusted to fit uniform time periods for the purpose of graphing (See Data 
Redisplay Intervals, p. 10 and Using Your Data in Other Applications, p. 29). 
 
Zooming in on any Plot Selection 

You can zoom in on any 
section of the plot.  This 
function is particularly 
useful when the plot 
encompasses a large 
data set.  Note that when 
the cursor is within the 
graph box, a Tracker Bar 
appears.  A vertical 
Tracker Bar is always 
present.  It is also 
possible to display a 
horizontal Tracker Bar 
by setting this option in 
the Graph tab in the 
Preferences screen 
(see Graph p. 10).  As 
the Tracker Bar is 
repositioned on the 
graph, the corresponding date, time, and associated data values appear in the status 
bar below the graph.  To zoom in on a particular section of a graph, position the cursor 
at one end of the time interval of interest.  While holding down the left mouse button, 
drag the Tracker Bar to the other end of the time interval.  After releasing the mouse 
button, the software will display a graph of the chosen region.  

Zooming Out One Level 
To return to a previous graph after zooming in on your graph, click on the Zoom Out 
quick-button (magnifying glass without the red circle) or the Zoom Out One Level 
command in the View menu.  Each time this button is clicked, the screen will return to 
the previous screen developed during the zooming-in process. 

Returning to the Original Plot View 
After zooming in on the data displayed in the graph screen, click on the Reset Zoom 
quick-button (magnifying glass with red circle) or the Reset Zoom command in the 

View menu to return to the original graph. 

Sample SpecWare Graph Screen. 
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Copying Graph 
To copy the graph as a bitmap for use in other applications, select Copy Graph from 
the Edit menu. 
 
Change Graph 
Selecting this option from the Edit menu will bring up the Change Graph Parameters 
screen.  This screen can also be accessed from the Change Graph Parameters 
quick-button on the SpecWare toolbar (below). 

 Change Graph 
Parameters 
quick-button  
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5.1.1 Select Report5.1.1 Select Report5.1.1 Select Report5.1.1 Select Report    

This screen allows the user to select the report of interest. There are two Report Cate-
gories: Standard Reports (see pp. 39-43), and Custom Reports (see p. 44) The Stan-
dard Reports are predefined reports for each of the sensor types.  Custom Reports al-
low you to create your own report in which you choose which parameters are dis-
played.   

The Reports screen is available in the Tools menu on the SpecWare toolbar (see 
Toolbar, p 12).  The Reports screen has 5 tabs; Select Report, Where and When, 

Options, Forecast, and View Report. 

5.1 Tools Menu5.1 Tools Menu5.1 Tools Menu5.1 Tools Menu    



36 

This screen allows you to produce reports for Logger Locations other than the one 
currently open.  Initially the default values for the location and process dates are from 
the file that is currently open.  To generate a report for another location or date, select 
a new Logger Location and enter the desired time period in the Process Dates 
boxes.  The calculations can begin and end on any date within a single year.  
SpecWare will not use data outside the chosen time period.  To generate a report that 
begins in one year and ends in the next (e.g. Chill Hours) you must calculate each year 
separately and manually sum the results. 

IMPORTANT: For your chosen  Location, make sure the Process Dates are included 
in the Available Months and that the Available Data include the appropriate 
parameters needed for the chosen Report or that are needed to drive the chosen 
disease or insect model.  

5.1.2 Where and When5.1.2 Where and When5.1.2 Where and When5.1.2 Where and When    

This screen allows modification of parameter ranges and boundary conditions specific 
to the Report, Disease, or Insect Model of interest.  Environmental inputs may include 
temperature, humidity and leaf wetness limits.  It may also be necessary to enter 
relevant biofix dates to indicate some visible stage of plant, disease, or insect 
development.  A spray date may be required to update infection potential calculations 
from that point on.  If a generally accepted value for a parameter exists, it is shown as 
the default.  Consult your State Agricultural Extension Service for assistance in 
determining the appropriate values for your area.  Once an appropriate value for each 

5.1.3 Options5.1.3 Options5.1.3 Options5.1.3 Options    
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of the parameters is determined, click on Save Parameters to avoid having to re-enter 
the values the next time the model is used. 

Forecast data is required for some disease and insect models.  It is possible to include 
forecast data for some other reports and predict environmental conditions up to one 
week in  the future.  It is also possible to enter forecast data for the present date if data 
for the entire day was not logged.  Check the Forecast Today box and enter the 
expected values for today’s Low and High temperature, Hours above 90% RH, 
Rainfall amount and Wet Leaf Hours.  Likewise, enter a forecast  for the next seven 
full days by entering values for these parameters on the line next to the appropriate 

5.1.4 Forecast5.1.4 Forecast5.1.4 Forecast5.1.4 Forecast    
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date.  When the report is viewed, an asterisk ( * ) will appear next to the forecasted 
dates to distinguish predictions based on forecasts from those based on actual 
measured data. 

On this screen, Report parameters or the results from disease or insect models are 
displayed.  If several different university models exist for a disease, they are shown in 
separate columns on the same report. 

You can save the current report by clicking the Write Text File button.  In the Save As 
screen, type a filename and select the directory where it will be saved. 

Clicking Print will cause the report to be sent directly to the printer. 

The Copy to Clipboard button allows the report to be copied and pasted into another 
document that has, for example, been created in a word processing or spreadsheet 
program.   

NOTE: If the report is saved directly to a spread sheet with Copy to Clipboard, it will 
not be separated into separate columns.  To parse the information into separate 
columns, use Write Text File to create a separate file.  Then open that text file in a 
spreadsheet as a space-delimited file.   

5.1.5 View Report5.1.5 View Report5.1.5 View Report5.1.5 View Report    
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Degree Days are computed for the Standard Degree Day Report (see figure below), 
Custom Reports, and for the Insect Models.  SpecWare calculates the total degree 
days accumulated and requires temperature data measured by the thermistor inside 
the WatchDog.  External temperature sensors cannot be used to generate these re-
ports.  (See Soil Temperature, p. 42).  Three methods are used to calculate degree 
days; Growing Degree Day, Single Sine, and Actual Degree Day.   

The Growing Degree Day Method (GDD) considers only the high and low temperatures 
(Thigh and Tlow) for the day along with user-selected values for the base and upper limit 
temperatures to compute the total number of degree days acquired. The formula is: 

½(Thigh + Tlow)  - Base 

If Thigh is above the upper limit, the upper limit is used for Thigh. If Tlow is below the base 
temperature, the base temperature is used for Tlow. In addition to the GDD, both the 
Single Sine and Actual (Integral) Degree Days are also displayed in the GDD report. 
The Single Sine method uses the day's maximum and minimum temperatures to gen-
erate a sine curve. The area between this curve and the lower threshold temperature is 
the GDD. The Actual Degree Days (ADD) method employs a calculation similar to the 
GDD but is done on the hourly values rather than on daily values. The ADD method is 
the most accurate. 

5.2.1 Degree Days5.2.1 Degree Days5.2.1 Degree Days5.2.1 Degree Days    

5.2 Standard Reports5.2 Standard Reports5.2 Standard Reports5.2 Standard Reports    
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5.2.2 Chill Hours5.2.2 Chill Hours5.2.2 Chill Hours5.2.2 Chill Hours    

SpecWare calculates the total chill hours.  Chill hours are calculated as the amount of 
time spent below a base temperature and above the lower limit. 

Leaf Wetness Hours 

SpecWare calculates the total leaf wetness hours accumulated between an upper and 
lower temperature limit.  This report requires leaf wetness and temperature data. 

5.2.3 Leaf Wetness Hours5.2.3 Leaf Wetness Hours5.2.3 Leaf Wetness Hours5.2.3 Leaf Wetness Hours    
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SpecWare calculates photosynthetically active radiation (PAR) received.  The PAR 
Light report shows total hours of accumulated PAR above a user-determined minimum 
light intensity and total moles meter

-2
 day

-1
 of photons.  The PAR sensor may be 

plugged into any port on the WatchDog.  If multiple PAR sensors are connected to the 
same WatchDog, a separate column is established for each PAR sensor.  SpecWare 
also calculates DIF and Daily Light Integral (DLI).  DIF is the average day temperature 
minus the average night temperature.  This value is used to determine stem elonga-
tion.  When day temperature is warmer than night temperature (positive DIF value) 
plants will become taller.  When day temperature is cooler than night temperature 
(negative DIF value) less stem elongation will occur.  DLI is the sum of all recorded 
PAR light throughout an entire day.  DLI  influences root and shoot growth as well as 
flowering. 

5.2.4 PAR Light, DIF/DLI5.2.4 PAR Light, DIF/DLI5.2.4 PAR Light, DIF/DLI5.2.4 PAR Light, DIF/DLI    

SpecWare calculates the hours of relative humidity that occur above an optional 
minimum percent RH and between a user-specified base and upper temperature limit.  
The report shows the sum of hours in which both the temperature and relative humidity 
conditions were satisfied. 

5.2.5 Temperature/RH Hours5.2.5 Temperature/RH Hours5.2.5 Temperature/RH Hours5.2.5 Temperature/RH Hours    

PAR Light Report DIF/DLI Light Report 
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SpecWare reports the high, low, and mean soil temperature for each day.  Integrated 
hourly degree days are calculated for each day using the user-specified lower and 
upper temperature limits. 

5.2.6 Soil Temperature Hours5.2.6 Soil Temperature Hours5.2.6 Soil Temperature Hours5.2.6 Soil Temperature Hours    

Day, Month, or Year Summary 
SpecWare summarizes the 
available data by hour for any 
single day, by day for any single 
month, or by month for any 
single year selected in the 
Where and When screen.  For 
each summary, the temperature 
limits for calculating degree days 
and chill hours can be specified 
in the Options screen.  The 
lower leaf wetness threshold 
and temperature range for calculating the hours of leaf wetness can also be specified. 

Day Summary (by Hour) reports mean hourly values of temperature, relative humidity 
and PAR light, hourly accumulation of degree days, chill hours, rainfall and the length 
of time the leaves were wet during the hour.  High and low temperatures for the time 
period of interest, as well as the time they occurred, are given at the bottom of the 
report.  Only one day’s data can be displayed. 

Month Summary (by Day) reports the daily mean temperature, high and low RH, high 
and low temperatures and the time they occurred, daily accumulation of degree days, 
chill hours, rainfall and the length of time the leaves were wet during the day.  Only one 
month’s data can be displayed. 

5.2.7 Day, Month, or Year Summary5.2.7 Day, Month, or Year Summary5.2.7 Day, Month, or Year Summary5.2.7 Day, Month, or Year Summary    
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Year Summary (by Month) reports the monthly mean temperature, high and low 
temperatures and the day they occurred, monthly accumulation of degree days, chill 
hours, leaf wetness hours, rainfall, the length of time the leaves were wet during the 
month and the number of days that rain fell during the month.  High and low 
temperatures for the year and the day they occurred are given at the bottom of the 
report.  

NOAA Report 
SpecWare summarizes weather 
station data in a format approved by 
t h e  Na t i o na l  Ocean i c  a nd 
Atmospheric Association.  The NOAA 
report includes the daily mean 
tempera tu re ,  h igh  and  low 
temperatures and the time they 
occurred, daily accumulation of 
integrated-hourly degree days, daily 
solar radiation in average watts 
meter

-2
 day

-1
, daily mean RH, daily 

rainfall, and the daily mean wind speed and maximum wind gust.  The Options screen 
is used to specify the temperature limits for calculating degree days.  Only one month’s 
data can be displayed. 

 

Irrigation Report 
A summary of the daily mean 
soil moisture readings as well as 
the amount of time the soil 
moisture tension was above or 
below the user-specified soil 
moisture range.  If data from a 
state sensor (item# 6451) is 
available, the last 2 columns will 
report the length of time the 
i r r i g a t i o n  s y s t em  wa s 
pressurized and how many 
gallons of water were applied to 
the field.   The soil moisture 
range and irrigation flow rate are 
set in the Options tab (see 

Options p. 43). 

5.2.8  NOAA/Irrigation Report5.2.8  NOAA/Irrigation Report5.2.8  NOAA/Irrigation Report5.2.8  NOAA/Irrigation Report    
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SpecWare 7 Pro gives users 
the ability to create custom-
ized, daily summary reports.  
Any parameter measured by 
the WatchDog data logger or 
weather station can be in-
cluded in these reports.  Af-
ter entering the Custom Re-
ports module (see Fig. 7) in 
the SpecWare Reports 
screen (see Select Report, 
pg. 35), you have the option 
of adding a new report or 
modifying or deleting an ex-
isting report.  To delete a report, highlight the name and click the Delete Custom Re-
port button in the lower left corner.  To add a report, click the Add New Custom Re-
port button and give a name for the new report in the Create New Custom Report 

Screen (see Fig. 8). 

To modify an existing report, simply high-
light that report.  The details about this 
report will then appear in the Report Col-
umns field on the right-hand side of the 
screen.  Columns in a report are added, 
modified and deleted with the appropriate 
button in the lower right-hand side of the 

Custom Reports module. 

 

Adding/Modifying a Custom Report Column 

To modify an existing column, 
highlight that column from the 
Report Columns field.  This 
will bring up the Report Col-
umns Options screen (Fig. 9).  
This same screen will also ap-
pear if a new column is being 
added.  From this screen, 
there are four options that 
must be selected.  They are as 
follows: 

5.2.9  Custom Reports5.2.9  Custom Reports5.2.9  Custom Reports5.2.9  Custom Reports    

Figure 7 

 

Figure 8 

 

Figure 9 
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Sensor Type 

The sensor type selected in the first field will determine what options are available in 
the other three fields.  If the Same option is selected, the sensor used in the previous 
column will be also be used in the column being added.  The column headings for each 

report column appear in the Report Headers field above the Report Columns field.   

Port 

After a sensor type has been selected, this option identifies the channel to which the 
sensor of interest is connected.  The default option for this category is Primary. If Pri-
mary is selected, SpecWare will initially look for an internal sensor of that sensor type. 
If none is found, it will look for the data file of the first external sensor (in alphabetic or-
der) of that sensor type.  This option should be selected if there are no duplicate sen-
sors connected to the WatchDog.  If more than one of the same sensor type is con-
nected to the data logger, select the location of the specific sensor that should be used 
in the report.   

If a letter (A - H) is selected, data from the sensor connected to this port will be used in 
the report. The External option is similar to Primary except SpecWare will only look for 
external sensors (currently, the only sensor type that can be either an internal or exter-
nal sensor is temperature).  The Any option is used for reports that contain data from 
several sensors of the same sensor type but, for which, the port the sensors are con-
nected to may change or vary from logger to logger.  When Any is selected, SpecWare 
will look for the first data file of that sensor type that has not already been used in the 
report. 

Note:  If a sensor type/location combination does not exist (for example, the 
Custom Report requires a solar radiation on channel B but no such data file ex-
ists because a temperature sensor is actually connected to that port), that report 
column will be blank when the report is displayed or printed out.   

Display 

The Custom Reports module pre-
sents information gleaned from an en-
tire day of data. The option selected 
here determines what information for 
the chosen sensor will be displayed.  
The options are summarized on the 
following pages: 

Mean, High, and Low-SpecWare will 
display the mean, high or low value  
measured by the selected sensor. 
 

Figure 10 
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Hrs-SpecWare will display the amount of time that the selected sensor was measuring 
values above a user-selected threshold value.  The field for entering this information 
will be in the same part of the screen where base temperature and upper limit are en-
tered for degree day reports (see fig. 10). 
 

DD, ADD, GDD and DDSine-This option is only available for temperature data.  
SpecWare will display the number of degree days accumulated for the day based on a 
user-defined base temperature and upper limit (see fig. 10).  The definitions of the dif-
ferent degree day options are: 
 DD:   Degree Days 
 ADD:   Actual Degree Days 

GDD:   Growing Degree Days 
DDSine:  Single Sine Method. 

See Degree Days (pg. 39) for more details on degree day computation.  

Flow-This option is only available for data from the Irrigation On/Off sensor.  Based on 
a user entered irrigation system flow-rate, SpecWare will display the total amount of 
irrigation water that was applied during the day. 

 
HiHrs and LoHrs- This option is only available for soil moisture data.  SpecWare will 
display the amount of time the selected soil moisture sensor was above (HiHrs) or be-
low (LoHrs) a user-defined threshold value. 
 
And Also 
 
With some options, the Custom Reports module gives the user the option of adding 
additional information that supplements the Display column.  This can be in the form of 
an additional column or an additional line of information at the end of the report.  The 
options are summarized below: 
 

None-This is the default option.  If it is selected, no supplementary information will ap-
pear in the report. 

 
Time-This option is available with the High and Low Display options.  It creates an ad-
ditional column that indicates when the respective high or low value occurred. 
 
Cumulative-This option is available with the Sum, Flow, Hrs, HiHrs, LoHrs and degree 
day Display options.  It creates an additional column that shows a running total of the 
accumulation of the desired parameter up to, and including, the day for which it is dis-
played. 
 
Total-This option is available with the Sum, Flow, Hrs, HiHrs, LoHrs and degree day 
Display options.  It creates an additional line at the end of the report that shows the 
sum of the desired parameter over the entire time range under consideration. 



47 

Optional Disease and Insect Models 
SpecWare software includes models to predict infection events for the following 
diseases and for insects.  These models are provided FREE for a 30 day evaluation.  If 
the user desires continued use of any of the disease or insect models after the 
evaluation period, or if any model was purchased initially with SpecWare, the user 
must contact Spectrum Technologies, Inc. for a registration number.   

Before calling Spectrum, click on the Help button on the main toolbar.  Then click on 
“About SpecWare”  A dialog box will appear with both the Serial Number and 
Registration Number.  Call, fax, or e-mail Spectrum with this information.  Currently, 
the optional  disease and insect models are as follows:     

          Catalog # 
Apple Scab (Venturia inaequalis)        3656 AS 
Black Rot (Guignardia bidwellii)        3656 BR 
Botrytis (Botrytis cinerea)         3656 BT 
Brown Patch (Rhizoctonia solani)         3656 BP 
Cherry Leaf Spot (Blumeriella jaapii)      3656 LS 
Dollar Spot (Sclerotinia homoeocarpa)       3656 DS 
Downey Mildew (Plasmopara viticola)      3656 DM 
Early Blight (Alternaria solani)       3656 EB 
Fire Blight (Erwinia amylovora)          3656 FB 
Late Blight (Phytophthora infestans)       3656 LB 
Powdery Mildew (Uncinula necator)     3656 PD 
Pythium Blight (Pythium aphanidermatum and P. graminicola)  3656 PT 
Sooty Blotch/ Flyspec (Peltaster fruticola and Leptodotium elatius     
Zygiophiala jamiacacenis)        3656 SB 
Tom-Cast (Alternaria solani, Spetoria Lycopersici)    3656 TC 
Insects           3656 IN 
 
For detailed descriptions of each model, refer to the SpecWare 7 Disease and Insect 
Guide. 

5.2.10 Disease and Insect Models5.2.10 Disease and Insect Models5.2.10 Disease and Insect Models5.2.10 Disease and Insect Models    
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The first launch of a 900ET Weather Station will enable the Evapotranspiration (ET) 

report option in the Tools menu on the SpecWare Toolbar. 

Note: The station Latitude and Altitude must be set in the Preferences screen (see 
p. 7). 

Where and When 
This screen allows you to produce reports for Logger Locations other than the one 
currently open (See p. 36). 

Crops 
The evapotranspiration (ET) 
v a l u e  c omp u t e d  b y 
SpecWare is the potential ET 
of a grass crop.  Actual ET 
for a specific crop at a 
specific growth stage can be 
computed with a crop 
coefficient (k).  The default k-
value is 1.0.  Crop 
coefficients are generally 
ava i l ab le  f rom loca l 
extension services.  This 
screen allows you to build 
reports for multiple crops.  To see what crops are already entered, click the arrow to 
expand the Crops field.  After choosing a crop, the data that has been entered for that 
crop can be seen in the Begin Dates - K Factors field.  To add a crop, left-click the 
Add button under the Crops field, enter the crop name, and click OK.  Enter the k 
factor and first date that factor is to be used by clicking the Add button under the 
Begin Dates - K Factors field.  Multiple k factors and begin dates can be entered for 
each crop, allowing the user to track crop water status as plant water requirements 
change.  The ET report can display the results of applied irrigation for each crop.  Click 
the Add button under the Irrigation Dates and Amounts field and enter the irrigation 
date and amount of water applied.  To change or delete data entered for any crop, 
highlight the data to be changed and click Delete.  Re-enter new or updated data as 
needed by using the Add button. 
 

5.2.11 Evapotranspiration5.2.11 Evapotranspiration5.2.11 Evapotranspiration5.2.11 Evapotranspiration    
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Report 
The Report screen lists the 
daily values for the 
parameters used to 
calculate ET.  Daily 
Reference ET is displayed 
and the Crop ET is 
calculated using the k 
values entered on the 
Crops screen.  Irrigation 
events are displayed as 
entered on the Crops 
screen and from the values 
for Irrigation. Crop ET, 
Rainfall, the daily Net Water increase or decrease, and the Cumulative Net water 
increase or decrease are also displayed. 

 

Graph 
The Graph screen is a pictorial display of pertinent information using the values from 

the Report screen.   
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 Commonly Asked Question 
 
Q.Q.Q.Q. When selecting Launch or Readout, the software gives the 
 message “Can’t connect to data logger” or “WatchDog Logger  
           Timeout”.  What’s wrong? 
 

A. Try changing the battery.  Otherwise, this is probably a serial 

port problem: 
1. Make sure that the interface cable is pressed all the way 

into the jack on the logger. 
 

2. The interface cable must be connected to a working serial 
port.  If the serial port was recently used for a network 
mouse, the port may still be configured as such.  When 
removing a mouse, reboot your system. 

 
3. If the logger still fails to connect, the battery could be low.    
     Replace the battery and try to connect again. 

 
 4. Set and/or test the communications port settings through    
                the Preferences screen in the File Menu. 
 
           5.  Check if software for any external devices (such as a palm   
                 pilot) has been installed on your hard drive. 
 
     

Help is available under 
Help Topics or the Knowledge Base at 

www.specmeters.com  

? 
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